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Introduction

 WARNING

Only qualified persons who are knowledgeable in the installation, operation, and 
maintenance of overhead and underground electric distribution equipment, along with 
all associated hazards, may install, operate, and maintain the equipment covered by 
this publication . A qualified person is someone who is trained and competent in:

 ● The skills and techniques necessary to distinguish exposed live parts from 
nonlive parts of electrical equipment

 ● The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed

 ● The proper use of special precautionary techniques, personal protective 
equipment, insulated and shielding materials, and insulated tools for working on 
or near exposed energized parts of electrical equipment

These instructions are intended only for such qualified persons . They are not intended 
to be a substitute for adequate training and experience in safety procedures for this 
type of equipment .

NOTICE

Thoroughly and carefully read this instruction sheet and all materials included in the 
product’s instruction handbook before installing or operating the IntelliNode Interface 
Module . Become familiar with the Safety Information and Safety Precautions on 
pages 4 through 5 . The latest version of this publication is available online in PDF 
format at https://www .sandc .com/en/contact-us/product-literature/ .

This instruction sheet is a permanent part of the IntelliNode Interface Module. Designate a 
location where users can easily retrieve and refer to this publication.

 WARNING

The equipment in this publication is only intended for a specific (application or 
applications) . The application must be within the ratings furnished for the equipment . 
Ratings for the IntelliNode Interface Module are listed in the ratings table in 
Specification Bulletin 1043-31 .

Qualified Persons

Read this 
Instruction Sheet

Retain this 
Instruction Sheet

Proper Application
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The standard warranty contained in S&C’s standard conditions of sale, as set forth in Price 
Sheets 150 and 181, applies to the IntelliNode Interface Module, except that the first para-
graph of the said warranty is replaced by the following:

(1) (1) General: The seller warrants to the immediate purchaser or end user for a 
period of 10 years from the date of shipment that the equipment delivered will be of 
the kind and quality specified in the contract description and will be free of defects 
of workmanship and material. Should any failure to conform to this warranty appear 
under proper and normal use within 10 years after the date of shipment, the seller 
agrees, upon prompt notification thereof and confirmation that the equipment has 
been stored, installed, operated, inspected, and maintained in accordance with the 
recommendations of the seller and standard industry practice, to correct the noncon-
formity either by repairing any damaged or defective parts of the equipment or (at 
the seller’s option) by shipment of necessary replacement parts. The seller’s warranty 
does not apply to any equipment that has been disassembled, repaired, or altered by 
anyone other than the seller. This limited warranty is granted only to the immediate 
purchaser or, if the equipment is purchased by a third party for installation in third-
party equipment, the end user of the equipment. The seller’s duty to perform under any 
warranty may be delayed, at the seller’s sole option, until the seller has been paid in 
full for all goods purchased by the immediate purchaser. No such delay shall extend 
the warranty period.

Replacement parts provided by the seller or repairs performed by the seller under 
the warranty for the original equipment will be covered by the above special warranty 
provision for its duration. Replacement parts purchased separately will be covered by 
the above special warranty provision.

For equipment/services packages, the seller warrants for a period of one year  
after commissioning that the IntelliNode Interface Module will provide automatic fault 
isolation and system reconfiguration per agreed-upon service levels. The remedy shall 
be additional system analysis and reconfiguration of the IntelliTeam® SG Automatic 
Restoration System until the desired result is achieved.

Warranty of the IntelliNode Interface Module is contingent upon the installation, 
configuration, and use of the control or software in accordance with S&C’s applicable 
instruction sheets.

This warranty does not apply to major components not manufactured by S&C, 
such as batteries and communication devices. However, S&C will assign to the imme-
diate purchaser or end user all manufacturer’s warranties that apply to such major 
components.

Warranty of equipment/services packages is contingent upon receipt of adequate 
information on the user’s distribution system, sufficiently detailed to prepare a 
technical analysis. The seller is not liable if an act of nature or parties beyond S&C’s 
control negatively impact performance of equipment/services packages; for example, 
new construction that impedes radio communication, or changes to the distribution 
system that impact protection systems, available fault currents, or system-loading 
characteristics.

Special Warranty 
Provisions
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Safety Information

Several types of safety-alert messages may appear throughout this instruction sheet and on 
labels and tags attached to the product. Become familiar with these types of messages and 
the importance of these various signal words:

 DANGER

“DANGER” identifies the most serious and immediate hazards that will likely result in 
serious personal injury or death if instructions, including recommended precautions, 
are not followed .

 WARNING

“WARNING” identifies hazards or unsafe practices that can result in serious personal 
injury or death if instructions, including recommended precautions, are not followed .

 CAUTION

“CAUTION” identifies hazards or unsafe practices that can result in minor personal 
injury if instructions, including recommended precautions, are not followed .

NOTICE

“NOTICE” identifies important procedures or requirements that can result in product or 
property damage if instructions are not followed .

If any portion of this instruction sheet is unclear and assistance is needed, contact the 
nearest S&C Sales Office or S&C Authorized Distributor. Their telephone numbers are 
listed on S&C’s website sandc.com, or call the S&C Global Support and Monitoring Center 
at 1-888-762-1100.

NOTICE

Read this instruction sheet thoroughly and carefully before 
installing the IntelliNode Interface Module .

If additional copies of this instruction sheet are required, contact the nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be 
replaced immediately. Replacement labels are available by contacting the nearest S&C 
Sales Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

Understanding 
Safety-Alert 
Messages

Following Safety 
Instructions

Replacement 
Instructions 
and Labels
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Safety Precautions

  DANGER
The IntelliNode Interface Module line voltage input range is 93 to 276 
Vac . Failure to observe the precautions below will result in serious  
personal injury or death .

Some of these precautions may differ from your company’s operating procedures 
and rules . Where a discrepancy exists, follow your company’s operating procedures 
and rules .

1 . QUALIFIED PERSONS . Access to the IntelliNode 
Interface Module must be restricted only to qualified 
persons . See the “Qualified Persons” section on 
page 2 .

2 . SAFETY PROCEDURES . Always follow safe 
operating procedures and rules .

3 . PERSONAL PROTECTIVE EQUIPMENT . Always 
use suitable protective equipment, such as rubber 
gloves, rubber mats, hard hats, safety glasses, and 

flash clothing, in accordance with safe operating 
procedures and rules .

4 . SAFETY LABELS . Do not remove or obscure 
any of the “DANGER,” “WARNING,” “CAUTION,” 
or “NOTICE” labels .

5 . MAINTAINING PROPER CLEARANCE . Always 
maintain proper clearance from energized 
components .
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Overview

IntelliNode Interface Modules shipped after March 31, 2013, have IntelliNode software 
version 3.5.0 or later. Previous software versions use an ICP Protocol at 9600 baud on the 
Local User port, Port D, on the Setup>Communications Comm. Setup>Serial Ports screen. 
Version 3.5.0 and later versions use the DNP protocol. 

If the system has IntelliNode Interface Modules with different software versions, 
switch to ICP for versions earlier than version 3.5.0 and DNP for versions at or later than 
version 3.5.0.
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Installing the Software on a Computer

The following are required to install IntelliNode Interface Module software on a computer:

• A portable personal computer with Windows 10, an Intel® Core™ i7 Processor with 8 GB 
of RAM (recommended) or a dual-core processor with 4 GB RAM (minimum), a wireless 
card (onboard or USB), an Internet browser, and access to sandc.com

• Administrative privileges

• Microsoft.Net Framework Version 4.8 (To verify whether it has been installed on a 
computer, open C:\Windows\Microsoft.Net\Framework with Windows Explorer. If v4.8 
has not been installed, download it from this link: microsoft.com/net. If the installer 
does not detect the correct version of .Net, it will not install IntelliLink6 software.)

• Windows PowerShell 5.0 set for an execution policy of AllSigned (RemoteSigned and 
Unrestricted execution policies will also work. Policy selection should be based on IT 
department security policy. The AllSigned execution policy will result in the appearance 
of a dialog box after a firmware update has begun.) 

• To perform the firmware update, the Run once or Always run button must be selected. 
Selection should be based on the IT department security policy. Windows PowerShell 
comes installed by default in every Windows operating system.

Follow these steps to set the AllSigned execution policy:

STEP  1 . Click on the Windows Start button and open the All Programs>Accessories> 
Windows PowerShell>Windows PowerShell (x86) option to start the application.

STEP  2 . In the PowerShell console, type set-executionpolicy AllSigned to set the policy.

STEP  3 . In the PowerShell console, type get-executionpolicy to verify the policy setting.

Computer 
Requirements
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Figure 1 . The S&C Customer Support Portal Login screen .

The latest IntelliNode Interface Module software version is posted at the S&C  
Automation Customer Support Portal. This library of existing and legacy software requires 
a password and gives users access to the software needed for S&C equipment operated by 
their utility. See Figure 1. Portal passwords may be requested by using  
this link: sandc.com/en/support/sc-customer-portal/.
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NOTICE
IntelliLink Setup Software version 7 .3 and later does not need to be activated and 
is backward-compatible with S&C automation controls with software versions 3 .5 .x 
and later . When installed, installation of a license-activation file is not required, and 
this section of this document can be disregarded . If using IntelliLink software with 
the IntelliCap® Plus Automatic Capacitor Control or any other products with earlier 
software versions in conjunction with products using software versions 3 .5 .x and later, 
an IntelliLink software license key must be obtained .

If unable to update to version 7.3, an account on the S&C Automation Customer Support Portal 
must used to obtain a license-activation file used with software versions 3.5.x to 7.1.x. A portal 
password can be obtained by using this link: sandc.com/en/support/sc-customer-portal/.

The first step is registering the computers that will require IntelliLink Setup Software. 
Register a computer with the MAC address for the Local Area Ethernet adapter. The MAC 
address can be obtained by using the ipconfig/all command in the command prompt. 
Make sure to obtain the onboard physical adapter and not an add-on or wireless adapter. 

If unfamiliar with the command prompt, obtain the S&C CheckMacAddress utility 
found in the IntelliTeam® SG Automatic Restoration System software workspace on 
the S&C  
Customer portal. See Figure 2. Send the MAC address in an email to  
GSMC@sandc.com with the name of the company that owns the IntelliLink software 
license, the name of the primary computer user, and the computer user’s email address and 
phone number. 

To see whether the computer has already been registered, select the Licensing tab to 
view a list of the computers registered to the account. Look for the designation of “INTEL-
LILINK REMOTE” software next to the computer’s MAC address.

IntelliLink® Setup 
Software License 
Activation

Figure 2 . The IntelliTeam SG software workspace on the S&C Automation Customer 
Support Portal .
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To save a license-activation file on a computer:

STEP  1 . Go to sandc.com, click on the Customer Portal tab, and click anywhere in the 
left column. Click on the S&C Automation Customer Support Portal option. 
Enter the appropriate username and password to gain access.

STEP  2 . Select the Licensing tab and verify there is a valid license and the correct MAC 
address for the computer.

STEP  3 . Select the Activation File tab. This generates a new license-activation file with 
the present information displayed at the Licensing tab. Then, the File Download 
dialog box opens.

STEP  4 . Click on the Save button and the Save As dialog box opens; save “ActivationFile.
xml” on the desktop.

Note: IntelliTeam® Designer software requires an account to have at least one asset regis-
tered with an IntelliTeam Designer slot. See S&C Instruction Sheet 1044-570, “IntelliTeam® 
Designer: User’s Guide” for more information about how to install and activate IntelliTeam 
Designer software.

Activate IntelliLink Software on the Computer
Save the ActivationFile.xml file in the folder: 

C:\Users\Public\Public Documents\S&C Electric 

This directory supports multiple users logging remotely into a Windows server.

Installing a License 
Activation File
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NOTICE
Some laptop computers may have a Wi-Fi adapter power setting set too low for LinkStart 
software to operate, resulting in the inability to connect to an IntelliNode Interface Module . 
Wi-Fi power settings are found in the control panel . To increase the Wi-Fi power setting:

STEP  1 . Go to the Control Panel>Power Options setting .

STEP  2 . Click on the Change Plan Settings option for the present plan .

STEP  3 . Click on the Change Advanced Power Settings option .

STEP  4 . Go to the Wireless Adapter Settings>Power Saving Mode>On battery 
setting .

STEP  5 . Change the setting to either “Low Power Saving” or “Maximum Performance .”

STEP  6 . Click on the OK button, and then click on the Save button to save the settings .

STEP  7 . A reboot may be required to engage the new configuration .

The Wi-Fi adapter may have a vendor-supplied option to set the power, and many Intel 
adapter drivers provide this . Open the Wi-Fi adapter Properties dialog box, and on the 
General tab click on the Configure button . Browse the tabs to determine whether there 
is a power setting (often found in the Advanced tab) . There may be additional settings, 
such as Transmit Power, that also can affect performance .

NOTICE
Port Requirements:

• IntelliLink Setup Software has a valid port range of 20000-20999 .

• LinkStart uses the following ports:

 — TCP Remote: 8828

 — UDP Remote: 9797

These two ports can be modified . To reconfigure either port, the port number must 
be updated in both LinkStart and in the R3 Communication Module . To update a port 
in LinkStart, select the Tools and TCP/IP Port Options menu options . Then, modify 
the value .

To update a port in the R3 Communication Module, open LinkStart and 
select the Tools and WiFi Administration menu options . This will open the  
R3 Communication Module web UI Login screen . Log in to the R3 Communication 
Module, click on the Interfaces menu option, and update the port .
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Establishing a Serial or Wi-Fi Connection

Figure 3 . The Windows Start menu .

Follow these steps to establish a computer connection to the control:

STEP  1 . Click on the Windows Start button and choose the All Programs menu item. 
Open the S&C Electric folder and click on the IntelliLink icon. See Figure 3.

Figure 4 . The S&C IntelliShell—Select Connection Mode dialog box .

STEP  2 . Select the Local Connection option in the S&C IntelliShell–Select  
Connection Mode dialog box. See Figure 4.
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Figure 5 . The S&C IntelliShell—Product Selection dialog box .

Figure 6 . The Communications Parameters entries within the S&C Electric IntelliShell—
Local Communication Setup dialog box .

STEP  3 . Select the IntelliNode Interface Module option and click on the Serial button 
to make a serial connection, or click on the Wi-Fi button to make a Wi-Fi connec-
tion. See Figure 5.

STEP  4 . If the Serial button was selected:

(a) Set the Comm Port setpoint appropriate for the computer.  

(b) Set the Timeout(ms) setpoint to 1000 or longer.

(c) Set the Baud Rate setpoint. The default baud rate for an IntelliLink  
software connection is 9600. If the baud rate setting was changed and is 
unknown, use the AUTO setting, and the IntelliLink software will try the 
available baud rates to attempt to make a connection.

(d) Click on the IntelliLink button. See the “Firmware Update” section on 
page 18 when a firmware update is required. See Figure 6.
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Figure 7 . The Wi-Fi Connection Management dialog box .

If the Wi-Fi button is selected:

(a) Use the Prev and Next buttons to select the control serial number, or enter 
the control serial number in the Serial Number field.

(b) Click on the Connect button. See Figure 7.

STEP  5 . The Ilink Loader dialog box will open followed by the S&C IntelliLink Login dialog 
box.  See Figure 8 and Figure 9 on page 15.  Enter the username and password, 
and click on the OK button. Contact the Global Support and Monitoring Center 
at 1-888-762-1100 if requiring assistance with these entries.
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Figure 8 . The User Name and Password entries in the S&C IntelliLink Login dialog box .

STEP  6 . If IntelliLink software is unable to connect, the Ilink  Loader dialog box will 
display “Could not connect to device.” Check the connection and settings.

Figure 9 . The Ilink Loader dialog box .
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Figure 10 . The IntelliNode module Operation screen .

NOTICE
With software version 7 .3 .100 and later, the default passwords for all user accounts, 
including the Admin user, must be changed before the IntelliLink software can connect 
to and configure a control .  See S&C Instruction Sheet 1043-531, “IntelliNode Interface 
Modules with IntelliTeam® SG Automatic Restoration System: Setup,” for more information . 

NOTICE
Wi-Fi Status and Transfer Wi-Fi configurations became no longer valid for Wi-Fi options 
shipped on or after January 1, 2021 .

STEP  7 . When the login has completed, the Operation screen opens. See Figure 10.
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Firmware Update

Complete the following steps to save the control configuration:

STEP  1 . On the menu bar, click on the File menu item and on the  Save Setpoints… option. 

STEP  2 . In the Save Setpoints dialog box, click on the Select All button followed by the 
… button. See Figure 11. The Save Setpoints dialog box will open. 

STEP  3 . Browse to the desired storage location, enter a name for the settings file, and 
click on the Save button in the dialog box.

NOTICE

Updating firmware can result in loss of settings . Always save the settings 
and a snapshot file before starting a firmware update .

Save Settings

Figure 11 . The Save Setpoints dialog box .

STEP  4 . To save a snapshot (a copy of the control memory, including logs), click on the 
File menu item in the menu bar and click on the Save Memory Snapshot option.
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NOTICE
Two files with the same firmware version (for example, 7 .5 .23 and 7 .5 .36) must not be 
installed on the computer during a firmware update or downgrade .

NOTICE
Updating firmware can result in loss of settings .  Always save the settings and save a 
snapshot file before updating firmware .

NOTICE
A remote or local update puts a control into the Prohibit Restoration state . When  
updating controls in an IntelliTeam SG Automatic Restoration System, use the following 
procedure:

STEP  1 . Upgrade the control software . This can be done with IntelliLink Setup Software 
or the IntelliLink software Remote option .

STEP  2 . After the update, verify all settings were preserved .

STEP  3 . Use the IntelliTeam Designer version compatible with the firmware version 
the control is running to re-push IntelliTeam SG system configurations to all 
FeederNets that have updated devices . See S&C Instruction Sheet 1044-570 
for the firmware-compatibility chart .

STEP  4 . If a device is an open point, push the configuration to both FeederNets for 
that device .

STEP  5 . Verify the team configurations .

STEP  6 . For IntelliNode modules only: Set the External Device Data Updated 
setting to the Running mode .

STEP  7 . Enable Automatic Restoration mode on all upgraded controls .

Complete the following steps to update the firmware:

STEP  1 . Start the IntelliLink software and select between a local or remote connection. 
See Figure 12.

Figure 12 . The S&C Electric IntelliShell—Local Communication Setup dialog box .

Firmware Update
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Figure 13 . The S&C Electric IntelliShell—Product Selection dialog box .

STEP  2 . Select the IntelliNode Interface Module option to update an IntelliNode control. 
Click on either the Serial or Wi-Fi button based on the communication method 
used to connect to the control. See Figure 13.

STEP  3 . If the Serial button is selected:

(a) Set the Comm Port setpoint appropriate for the computer.  

(b) Set the Timeout(ms) setpoint to 1000 or longer.

(c) Set the Baud Rate setpoint. The default baud rate for an IntelliLink  
software connection is 9600. If the baud rate setting was changed and is 
unknown, use the Auto setting, and the IntelliLink software will try the 
available baud rates to attempt to make a connection.

(d) Click on the Update Firmware button. See Figure 14.

Figure 14 . The S&C IntelliShell—Local Communication Setup dialog box .
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Figure 15 . The connection successfully completed indication .

STEP  4 . When the connection is successful, click on the Firmware Update button. See 
Figure 16.

Figure 16 . The Wi-Fi connection Management dialog box .

If the Wi-Fi button was selected: LinkStart software starts and the device 
serial number must be entered in the Serial Number field. Then, click on the 
Connect button. See Figure 15.
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Figure 17 . The Tools>Firmware Update menu option .

Figure 18 . The Choose Revision dialog box for selecting the firmware version .

STEP  5 . In the Tools menu on the menu bar, click on the Firmware Update menu  option. 
See Figure 17.

STEP  6 . When the firmware update Choose Revision dialog box appears, select the firmware 
version to update the control to. See Figure 18.

Note: This dialog box only appears if the control is already on the version the 
upgrade is being performed on. Otherwise, it will not appear, and the upgrade 
script will upgrade the control to the latest firmware downloaded on the 
computer where the upgrade is being performed.
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Figure 19 . The Firmware Update dialog box .

STEP  9 . In the Firmware Update dialog box, click on the Yes button. See Figure 21. Selecting 
“No” will end the Update process.

Figure 20 . The Firmware Update dialog box upgrade method choice .

Figure 21 . The MCU OS revision dialog box .

STEP  7 . The Firmware Update dialog box will prompt for selection of the update method. 
Click on one of the options to proceed. See Figure 19.

Note: This dialog box only appears when upgrading from software version  
7.3.x to 7.5.x or later.

 Note: The Compact Flash option is more robust because it downloads the 
firmware image to the compact flash memory before applying the firmware 
update. This should be used when updating remotely because it compensates 
for communication disruptions but takes longer to perform. The Legacy option 
is less robust because it sends the firmware file to the control and applies the 
update without staging it in the compact flash memory. It should only be used 
with a local connection to the control.

STEP  8 . The Firmware Update dialog box may ask about the MCU OS revision. Click on 
the Yes button if this dialog box opens. See Figure 20.
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Figure 22 . The Firmware Update dialog box requesting password retention .

Figure 23 . The Firmware Update dialog box requiring passwords that meet complexity 
requirements .

STEP  10 . If the dialog box prompts to retain passwords, click on one of the options to 
proceed. See Figure 22.

Note: This dialog box only appears when updating from software version  
7.3.x to 7.5.x. When upgrading from any release to version 7.6.x or later, the 
existing passwords will be retained. If the passwords are still at the default 
passwords, then the Admin user will be required to change them to one that 
meets the password complexity requirements upon initial login after the 
firmware update is completed.

 Note: When “Yes” is selected, all user passwords are retained during the 
update. However, if the passwords do not meet the complexity requirements, 
the Admin user must change them at the initial login after an update to meet the 
requirements. See Figure 23. 

When “No” is selected, after the update all passwords will revert to the 
defaults. At initial login, all passwords must be changed to meet the password 
complexity requirements.
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Figure 24 . The Windows Powershell Credential dialog box .

STEP  11 . If the Windows PowerShell Credential dialog box appears, enter the User Name 
and Password, and click on the OK button. Contact the Global Support and 
Monitoring Center at (888) 762-1100 if assistance is needed. See Figure 24.
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Figure 25 . The Script completed successfully notice .

STEP  12 . When “Script completed successfully” is indicated in the Firmware Update dialog 
box, click on the Close button. See Figure 25.

NOTICE
If power is disrupted during a firmware update using the Compact Flash option, Cyclic 
Redundancy Check (CRC) errors may occur . If this happens, the compact flash must 
be formatted before another update can be attempted using the Compact Flash option .
The Legacy option can be used to perform the update . See the “Memory Formatting” 
section in S&C Instruction Sheet 1032-570, “IntelliLink® Setup Software—Compact 
Flash Access: Operation .”
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Firmware Downgrade

In some cases, reverting to a previous version of IntelliNode module firmware may be 
necessary. Follow these steps to go to a previous revision:

STEP  1 . Choose the required firmware downgrade and obtain the software from the  
S&C Automation Customer Support Portal. See the “Software Versions“ 
section in S&C Instruction Sheet 1043-531 for more information about the  
S&C Customer Portal.

STEP  2 . Click on the Start  button, and select the Control Panel  option.  
See Figure 26.

Figure 26 . The Windows Start Menu .
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Figure 27 . The Control Panel dialog box .

STEP  3 . From the dialog box, select the Programs>Uninstall A Program option.  
See Figure 27.

STEP  4 . Uninstall all IntelliNode Interface Module software versions later than the target  
version. If there are multiple versions, work from the latest first to the earliest last.

STEP  5 . If any IntelliLink Setup Software is already installed, remove it by uninstalling 
it from the Windows program by choosing the Uninstall option. See Figure 28.

Figure 28 . Select the program folder to be uploaded .
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STEP  6 . Open the Windows File Explorer screen and navigate to the program folder  
C:\Program Files (x86)\S&C Electric\Products\IntelliNode\Firmware\Upgrades. 
See Figure 29. Delete any folders that have a version number later than the target 
downgrade version.

Figure 29 . The C:\Program Files (x86)\S&C Electric\Products\IntelliNode\Firmware\Upgrades 
dialog box .

STEP  7 . Run the installer for the target version. If the target downgrade version is already 
installed, select the Repair option when it is presented by the installer.

NOTICE
With software later than version 7 .3 .100, the default passwords for all user 
accounts, including the Admin account, must be changed before the IntelliLink 
software can connect to and configure a control . See S&C Instruction Sheet 
1043-531, “IntelliNode Interface Modules with IntelliTeam® SG Automatic 
Restoration System: Setup,” for more information .

STEP  8 .  Start the IntelliLink software. 

STEP  9 . Set the Timeout(ms) setpoint to 1000 or longer.

STEP  10 . Set the Baud Rate setpoint. The default baud rate for an IntelliLink  
software connection is 9600. If the baud rate setting was changed and is unknown, 
use the Auto setting, and the IntelliLink software will try the available baud rates 
to attempt to make a connection.

STEP  11 . Click on the Update Firmware button. See Figure 30.

Figure 30 . The S&C Electric IntelliShell—Local Communication Setup dialog box .
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STEP  12 . Enter the Admin password when prompted to enter credentials. The default 
password can be obtained by contacting the Global Support and Monitoring 
Center at (888) 762-1100. If the default password has been changed, enter the 
user-configured password.

STEP  13 . In the Tools menu on the menu bar, click on the Firmware Update menu item.  
See Figure 31.

Figure 31 . The Tools>Firmware Update Menu option .

STEP  14 . When the Firmware Update Choose Revision dialog box appears, select the 
desired firmware version. See Figure 32.

Figure 32 . The Firmware Update Choose Revision dialog box for selecting the firmware 
version .
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STEP  15 . The Firmware Update dialog box will prompt for selection of the update or down-
grade method. Click on one of the options to proceed. See Figure 33.

Note: This dialog box only appears when downgrading from software version  
7.5.x or later to another 7.5 release or a 7.3 release.

 Note: The Compact Flash option is more robust because it downloads the 
firmware image to the compact flash memory before applying the firmware 
update. This should be used when updating remotely because it compensates 
for communication disruptions but takes longer to perform. The Legacy option 
is less robust because it sends the firmware file to the control and applies the 
update without staging it in the compact flash memory. It should only be used 
with a local connection to the control.

Figure 33 . The Firmware Update dialog box .

Figure 34 . The MCU OS revision dialog box .

Figure 35 . The Firmware Update dialog box .

STEP  16 . The Firmware Update dialog box may ask about the MCU OS revision. Click on 
the Yes button if this dialog box appears. See Figure 34.

STEP  17 . In the Firmware Update dialog box, click on the Yes button. See Figure 35. Selecting 
“No” will end the Downgrade process.
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STEP  18 . When downgrading from software version 7.3.100 or later to a software release 
earlier than 7.3.100, a dialog box will appear about the passwords being reverted 
to defaults during the downgrade process. Click on the Yes button to proceed 
with the downgrade. Clicking on the No button will stop the downgrade process. 
See Figure 36.

Note: When downgrading from software version 7.6.x or later to a 7.5.x or 7.3.1x 
version, the passwords will always be retained. If any of the users account pass-
words are still at the default value, the Admin must change them to a password 
that meets the complexity requirements before those user accounts can login.

STEP  19 . If the Windows PowerShell Credential dialog box appears, enter the same password 
entered in Step 12 on page 29. See Figure 37.

Figure 36 . The Default Passwords downgrade message .

Figure 37 . The Windows PowerShell Credentials dialog box .
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STEP  20 . When downgrading from software version 7.3.100 or later to software version 
7.3.x or earlier, a dialog box will appear about the passwords being reverted 
to defaults after the downgrade process completes. Click on the OK button to 
proceed. See Figure 38.

STEP  21 . When “Script completed successfully” is indicated in the Firmware Update dialog 
box, click on the Close button. See Figure 39.

Figure 38 . The message that appears after reverting passwords to defaults after a down-
grade process completes .

Figure 39 . The “Script completed successfully” message .
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